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F.1.  Overview of SEFA Reporting 
 

To comply with the Single Audit Act and requirements found at 2 CFR Part 200, Uniform 
Administrative Requirements, Cost Principles, and Audit Requirements for Federal Awards (Uniform 
Guidance), a statewide Schedule of Expenditures of Federal Awards (SEFA) is prepared each fiscal 
year. Federal assistance data is provided to Statewide Accounting and Reporting Services (SARS) 
by state agencies for statewide compilation of the SEFA and subrecipient reports. 
 
F.2.  History of Federal Reporting  
 

Under the Single Audit Act of 1984, multiple grant audits of the past were replaced by a "single" 
audit specifically designed to meet the needs of all federal grantor agencies. Individual grantors 
would still retain the right to have additional audit work performed, but they would be required to pay 
for it and it would build on the work already done by the Single Audit. The provisions of the Single 
Audit Act applied to all government agencies receiving federal financial assistance in excess of 
$25,000. For the purposes of the Act, federal financial assistance was very broadly defined and 
included noncash assistance such as loan guarantees, food stamps, and surplus property. However, 
federal financial assistance did not include cash assistance furnished directly to individuals.  
 
In addition to the requirements specifically outlined in the Single Audit Act, further guidelines of the 
Office of Management and Budget's (OMB) Circular A-128, Audits of State and Local Governments 
were to be followed. In 1985, OMB issued a Compliance Supplement that contained nine general 
requirements applicable to all federal assistance programs. Also, the supplement contained specific 
requirements for individual programs as defined by their CFDA (Catalog of Federal Domestic 
Assistance) number. 
 
In 1990, OMB extended the single audit process to non-profit organizations by issuing OMB Circular 
A-133, then titled Audits of Institutions of Higher Education and Other Non-Profit Organizations. A 
compliance supplement similar to the one issued for Circular A-128 was also issued for Circular A-
133.  
 
In April 1996, OMB revised Circular A-133 in anticipation of an amendment to the Single Audit Act. 
Because A-133 was administratively issued by OMB and was not specifically tied to the Single Audit 
Act, OMB was able to implement changes to that circular in advance of the actual passing of the 
amendment to the Single Audit Act. The revised circular contained many of the changes in the 
amendment and was expected to need only minor revisions once the Single Audit Act amendment 
was passed.  
 
The Single Audit Act was amended in July of 1996. The primary change allowed OMB to make more 
specific prescriptions, similar to what Circular A-133 had done in the past.  
 
With the passing of the amendments to the Single Audit Act, OMB Circular A-133 was modified to 
reflect the final language of the act and to include audits of state and local governments. It was now 
titled Audits of States, Local Governments, and Non-Profit Organizations and OMB Circular A-128 
was rescinded. This revision was issued on June 24, 1997 and covered audits of fiscal years 
beginning after June 30, 1996. 
 
On June 27, 2003, OMB issued a subsequent revision to OMB Circular A-133, which was effective 
for fiscal years ending after December 31, 2003. This revision increased the threshold for Single 
Audit from $300,000 to $500,000.  
 
Prior to December 26, 2014, the U.S Office of Management and Budget (OMB) used eight different 
circulars applicable to federal grants. However, as of that date, any new or modified grants use 
Uniform Guidance. The circulars listed below are still in effect for any grant awarded prior to 
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December 26, 2014. However, if a state agency has received funding increments on those grants 
with changed award terms and conditions after that date, Uniform Guidance applies. The circulars 
superseded by Uniform Guidance are identified below: 
 

• A-21 Cost Principles for Educational Institutions 
• A-50 Audit Follow-up 
• A-87 Cost Principles for State, Local and Indian Tribal Governments 
• A-89 Federal Domestic Assistance Program Information 
• A-102 Grants and Cooperative Agreements with State and Local Governments 
• A-110 Uniform Administrative Requirements for Awards and Other Agreements with 

Institutions of Higher Education, Hospitals, and Other Non-Profit Organizations 
• A-133 Audits of State, Local Governments and Non-Profit Organizations 

Under Uniform Guidance the Single Audit threshold was again raised, from $500,000 to $750,000. 
This increased audit threshold was effective for the state’s fiscal year 2016 and it applies to all 
federal awards, even if the federal award is otherwise subject to the prior circulars as described 
above. 

F.3.  Current Single Audit Requirements  
 

• An entity is exempt from Single Audit requirements if the entity expends less than 
$750,000 in total federal assistance in its fiscal year.  

 
• An entity may elect to have a program specific audit if they expend funds only under 

one federal program (excluding research & development) and the federal program's 
statutes, regulations, or terms and conditions of the federal award do not require a 
financial statement audit of the auditee.  

 
• An entity that expends $750,000 or more in federal assistance in a year shall have a 

Single Audit conducted in accordance with the Single Audit Act and Uniform Guidance, 
except when they elect to have a program specific audit, as allowable.  

 
F.4. SEFA Reporting Requirements 
 

 F.4.a. When is a Federal Award Expended? 
 

The determination of when an award is expended is based on when the activity related to the award 
occurs. In general, the activity pertains to events that require auditees to comply with laws, 
regulations, and the provisions of contracts or grant agreements. Such events include but are not 
limited to the following: 
 

• Expenditures/expense transactions associated with grants, cost reimbursement contracts, 
cooperative agreements, and direct appropriations 

 

• The disbursement of funds passed through to subrecipients 
 

• The use of loan proceeds under loan and loan guarantee programs 
 

• The receipt of property 
 

• The receipt of surplus property 
 

• The receipt or use of program income 
 

• The distribution or consumption of food commodities 
 

• The distribution of amounts entitling the auditee to an interest subsidy 
 

• The period when insurance is in force 
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F.4.b. Expenditures of Non-Cash Awards 
 

Most federal awards are in the form of cash awards. However, there are a number of federal 
programs that do not involve cash transactions. These programs have specific guidelines to 
determine when they have been expended and should be included in the SEFA: 
 
Donated property or donated surplus property: Fair market value of donated property or donated 
surplus property at the time of receipt, or the assessed value provided by the federal agency.  
 
Free rent: Fair market value of free rent at the time of receipt, or the assessed value provided by the 
federal agency. Free rent is not considered an award expended unless it is received as part of an 
award to carry out a federal program.  
 

F.4.c. Loans and Loan Guarantees 
 

These programs have specific guidelines to determine when they have been expended and should 
be included in the SEFA: 
 
Loans and loan guarantees: Value of new loans made or received during the fiscal year plus the 
balance of loans from previous years for which the federal government imposes continuing 
compliance requirements plus any interest subsidy, cash, or administrative cost allowance received.  
 

F.4.d. Medicare 
 

Medicare payments to a non-federal entity for providing patient care services to Medicare-eligible 
individuals are not considered federal awards expended for reporting on the SEFA.  
 

F.4.e. Medicaid 
 

Medicaid payments to a subrecipient for providing patient care services to Medicaid-eligible 
individuals are not considered federal awards expended for reaching the threshold amount that 
requires a Single Audit. For purposes of SEFA reporting, the Medicaid expenditures must be 
reported. When subrecipient monitoring assignments are made, the Medicaid payments will be 
eliminated. Medicaid is not included in the threshold amount to require an entity to have a Single 
Audit because there is already separate and sufficient monitoring of this program being done. 
 

F.4.f. Distinguishing Between Subrecipient and Contractor  
 

An entity may concurrently receive federal awards as a recipient, a subrecipient, or a contractor 
depending upon the substance of its agreements with federal award. Federal awards expended as a 
recipient or as a subrecipient may be subject to audit under Uniform Guidance. The payments 
received for goods or services provided as a contractor would not be considered federal awards to 
the contractor, but would be considered federal expenditures by the agency recording the payment 
and need to be reported as direct expenditures in the agency’s SEFA reports. Uniform Guidance 
provides direction on determining whether payments constitute a federal award or a payment for 
goods and services. This determination also helps an agency to correctly record transactions (see 
Oregon Accounting Manual (OAM) 15.42.00 on accounting for federal grants). Because an entity 
may be a subrecipient for one for one federal and a contractor for another, it’s important to make this 
determination on a case-by-case basis for each agreement. In addition, it is the responsibility of the 
pass-through entity to determine whether the entity receiving the funds is a subrecipient or a 
contractor.  If the pass-through entity determines the receiving entity is a subrecipient, it must ensure 
that the subaward clearly identifies the receiving entity as a subrecipient. The chart below may be 
useful to determine whether payments constitute a federal award or a payment for goods and 
services.  
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Federal Award 
Subrecipient 

 Payment for Goods and Services 
Contractor 

   
1. Determines who is eligible to 

receive what federal financial 
assistance. 

 1. Provides the goods and services 
within normal business 
operations. 

   
2. Has its performance measured 

against whether the objectives of 
the federal program are met. 

 2. Provides similar goods or 
services to many different 
purchasers. 

   
3. Has responsibility for 

programmatic decision-making. 
 3. Normally operates in a 

competitive environment. 
   
4. Has responsibility for adherence 

to applicable federal program 
compliance requirements. 

 4. Provides goods or services that 
are ancillary to the operation of 
the federal program. 

   
5. Uses the federal funds to carry 

out a program for a public 
purpose in statute as compared 
to providing goods or services for 
a program of the pass-through 
entity (the State). 

 5. Is not subject to compliance 
requirements of the federal 
program as a result of the 
agreement.  

 
Uniform Guidance recognizes that not all of the characteristics will be present in all cases and that 
professional judgment should be used in determining whether an entity is a subrecipient or a 
contractor. In making this determination, the substance of the relationship is more important than the 
form of the agreement.  
 
F.5. Transfers of Federal Assistance Between State Agencies  

 

When federal assistance is transferred from one state agency to another, the expenditure should be 
reported in the SEFA only once for the State of Oregon as an entity. For the most part, distributions 
from one agency to another should be reported as transfers for SEFA reporting purposes. The 
receiving agency will record a transfer in, and the sending agency will record a transfer out; these 
amounts will be equal and offset for the same CFDA number in the agencies’ SEFA reports. 
Agencies are responsible to coordinate their SEFA reporting with other agencies to ensure that both 
agencies are reporting transfers for the same amount and with the same CFDA number. The 
receiving agency will report SEFA expenditures when it expends the federal assistance; this is the 
case even when the receiving agency budgets the money as other funds (known as “federal funds 
budgeted as other funds”) since the money originated from a federal source.  
 
In a few cases, a state agency will use federal assistance to pay for goods or services obtained from 
another state agency. If this occurs, the paying agency reports an expenditure (to a “contractor”) in 
its SEFA report, and the receiving agency will not report the amount received in its SEFA report. 
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F.6. SEFA Year-End Reporting 
 

The SEFA reports the total expenditures for each federal program. Statewide Accounting and 
Reporting Services (SARS), which is part of the Chief Financial Office at the Department of 
Administrative Services, compiles this information for the State of Oregon based on information 
provided by state agencies. Each agency receiving any kind of federal assistance is responsible to 
ensure federal funds are accounted for properly to support accurate reporting in the SEFA. Agencies 
on R*STARS are required to account for federal funds in accordance with OAM 15.42.00 to facilitate 
the use of electronic reporting of R*STARS data (agencies that interface data to R*STARS were 
encouraged but not required to use specific grant profiles in R*STARS). The structures described in 
OAM 15.42.00 are very important to the proper reporting of federal funds using the Datamart 
Repository. 
 
Agencies will use standard reports, available on the Datamart Repository, to transmit information for 
SEFA year-end reporting. Each agency is responsible to run reports for their agency, review the 
reports for accuracy, and transmit the information to SARS after the close of Month 13 by sending a 
repository query file with results saved (refer to F.6.g., Using the SEFA Reports). SARS provides a 
SEFA checklist to help agencies with their review. In addition, agencies receiving any kind of federal 
assistance need to complete year-end SEFA disclosure forms. The information reported by agencies 
for the SEFA as well as information provided through disclosure forms is transmitted to SARS at 
year-end through a Transmittal of SEFA Disclosures and Agency Certification (refer to Form I.3). 
This certification form is signed by the agency’s SEFA contact and the chief fiscal officer or director. 
For internal control purposes, the SEFA contact and chief fiscal officer/director must be different 
individuals. 
 
The “SEFA Reports 20XX” query file on the Datamart Repository includes six individual reports: 1) 
Expenditures, 2) Revenues, 3) Transfers In, 4) Transfers Out, 5) Subrecipient and 6) SEFA 
Inflow/(Outflow) report. That query file also includes quarterly reports of expenditures, a more 
detailed subrecipient expenditures report, and a revenue report. The “SEFA Reports 20XX Express” 
file omits the quarterly reports of expenditures, and the “SEFA Reports 20XX Express YE” (Month 
13 only query) omits both the quarterly reports and the subrecipient reports. 

F.6.a.  Expenditures Report 
 

This report displays total expenditures of federal awards by CFDA number. Total expenditures result 
from adding direct expenditures together with amounts passed-through to subrecipients. The total 
amount reported for "Pass-through to Subrecipients" must equal the detailed information reported on 
the "Subrecipient" report. In addition, this report displays whether expenditures resulted from a direct 
award (received by the agency directly from a federal agency) or from an indirect award (received by 
the agency as a subrecipient from a non-federal entity). 
 

F.6.b. Revenues Report 
 

This report includes all federal revenues that have been received by agencies, whether received 
directly from a federal agency or indirectly from another organization. Revenues are displayed by 
CFDA number and by grantor, with direct awards and indirect awards reported separately. It is 
important that the source of the award received be considered. Money that originally came from the 
federal government continues to be federal funds until spent on the actual federal program. Thus, 
federal awards need to be reported as such even if the awards have passed through numerous 
different organizations. Federal awards received from another state agency as pass-through should 
not be recorded as federal revenue; instead, the money should be recorded as a transfer in.  
 

F.6.c. Transfers In Report 
 

This report displays federal money that was transferred in to one state agency from another state 
agency. If the source of the money is federal, the transfer should be accounted for and associated 
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with a CFDA number, regardless of whether it is budgeted as a transfer of federal or other funds. 
Please be sure the sending agency records a transfer out for the same amount and uses the same 
CFDA number. 

F.6.d. Transfers Out Report 
This report displays federal money that was transferred out from one state agency and sent to 
another state agency. If the source of the money is federal, the transfer should be accounted for and 
associated with a CFDA number, regardless of whether it is budgeted as a transfer of federal or 
other funds. Please be sure the receiving agency records a transfer in for the same amount and 
uses the same CFDA number.  

F.6.e.  Subrecipient Report  
 

This report includes federal awards that were distributed (passed through) to a subrecipient 
organization by CFDA number. This detail report showing “Total Amount Passed Through” must 
agree to the amount reported in total as “Pass Through to Subrecipients” on the expenditures report. 
Another state agency is not considered a subrecipient organization; federal awards passed through 
to another state agency should be recorded as transfers out. In addition, a federal agency cannot be 
a subrecipient (it can be a contractor), so federal agencies should not appear on this report.  Lastly, 
it is critical that all subrecipient data be identified on the report, including the award contract number, 
subrecipient tax ID, and subrecipient organization.  Utilizing placeholders that simply identify a 
CFDA number and amount, with the intention of providing the details with a SEFA correction form, 
causes problems for subrecipient monitoring assignments.   

F.6.f.  SEFA Inflow/(Outflow) Report 
This report summarizes all previous reports (a. - e.) and provides a net inflow/(outflow) amount 
sorted by CFDA, grant number, and PCA. This report is a tool for agencies to review their federal 
data in detail. Revenues plus transfers-in should approximately equal expenditures plus transfers-
out. 

F.6.g.  Using the SEFA Reports 
At fiscal year-end, agencies will use the SEFA reports to transmit SEFA information to SARS. Each 
agency is responsible to run reports for their agency, review the reports for accuracy, and transmit 
the information to SARS. After the close of Month 13, agencies will send to SARS a file with results 
saved. Below are instructions for using the SEFA reports on the Datamart Repository.  
 

1. To access the SEFA reporting queries, open Hyperion Interactive Reporting Studio. Click 
Cancel if you get a dialog box to open files or an OCE. 

  
2. Select File > Open from Repository > Select. Select the OCE that connects to the 

repository.  
 
Note: Instructions to set up an OCE, which includes the repository connection along with the 
regular Datamart, can be found at: 
https://www.oregon.gov/das/Financial/AcctgSys/Pages/datamart.aspx. 
 
 
 
 
 
 

 
  

https://www.oregon.gov/das/Financial/AcctgSys/Pages/datamart.aspx
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3. In this example, the OCE is called “Repository.oce”. Your OCE name may be different. You 
should see a screen similar to the following: 

 

  
 
 

4. Select Open. Enter your Datamart login (if needed) and password. You should see a screen 
similar to the following: 
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5. Click on the  next to “Standard Query with Reports”. Your screen should look like the 
following (again this may be somewhat different depending on your OCE setup; you may not 
see anything but the three folders “Data Model”, “Standard Query” and “Standard Query with 
Reports”): 

 

  
 
Scroll down until you see the file “SEFA Reports”. Select it and click Open. 
 

6. The SEFA reports query should now be open in Hyperion. The opening screen looks like the 
following and contains helpful federal links at the bottom of the page: 
 

 
 

7. Input your Agency, RACF ID and Password in the indicated boxes. You must tab or click 
between the boxes. Hitting Enter will cause unexpected results – many times a blank report 
and no data returned. If this happens to you, close the file and open a new one from the 
repository). Then, click on the Process button, which processes the queries to populate the 
SEFA reports. 
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8. After the queries have processed, use the Report Selector dropdown box on the IR Studio 
EISMain page to access the reports available in the query file. Click on the name of the 
report desired. The available reports are described above in F.6.a through F.6.f. These 
reports are designed to pull data based on the use of Grant Profiles and the application of 
standard accounting as outlined in OAM 15.42.00 on Federal Grants. Note: if your agency is 
not using the required profiles or is not following the standard accounting treatment, the 
reports will not be accurate. If data is missing, review your accounting processes related to 
federal grants and make corrections as needed.  

 

 
 

 
9. Clicking on the report in the list will take you to the selected report. The example below 

shows the Expenditures report.  
 



Chapter F – Schedule of Expenditures of Federal Awards F - 10 
Revised 06/2020 

 
 
 

10. To return to the main page, click on the arrow or the “home” button as indicated above.  
 

11. To save the file with results, select File > Save Options > Save Query Results With 
Document. A popup menu will appear, and you need to check all "query results" and 
"computed columns" boxes, then click OK. Then select File > Save As and select the 
appropriate directory to save. The file will save results and calculated fields.  

 
12. Review the results in your agency’s SEFA repository reports for accuracy and completeness. 

Send the file (with results saved) as an attachment in an email to your SARS analyst, along 
with the Transmittal of SEFA Disclosures and Agency Certification form.   
 
F.6.h. Making Corrections to SEFA Information 
 

Upon review of the SEFA repository reports, an agency may discover that the information 
transmitted to SARS through the reports is inaccurate or incomplete. When this occurs, agencies 
use the Excel “Corrections” spreadsheet, which is sent to agencies in mid-July, to make corrections 
to information already transmitted to SARS. Indicating the amount originally reported, as well as the 
corrected amount, assures the intended correction is made. In addition, this process provides 
documentation of changes to initial data for the Statewide Single Audit. If corrections are needed, 
indicate the corrections, and return the completed spreadsheet to SARS as an email attachment.  
 
Note: as agencies become aware of proposed material adjustments after the close of Month 13, the 
agency is responsible for determining if the adjustments have an impact on the agency’s SEFA. If 
the adjustment affects the agency’s SEFA, a “Corrections” spreadsheet may be required. Contact 
the agency’s SARS analyst and provide the CFDA number and title. 
 

F.6.i. Alternative (Manual) SEFA Reporting Process 
 

Agencies that interface transactions to R*STARS and are not using the federal grant profiles as well 
as agencies that are not on R*STARS will transmit their SEFA information to SARS at year-end 

Click Either Icon 
to return to the 

Main page 
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using Excel spreadsheets. These spreadsheets will be provided to applicable agencies by SARS. 
Agencies will complete the spreadsheets and transmit them to SARS as an email attachment. This 
information will be compiled together with data transmitted by other agencies through the Datamart 
Repository reports and incorporated into the statewide SEFA. An agency needs to have approval 
from SARS in order to use this alternative process.   
 

F.6.j. SEFA Disclosure Forms 
 

Agencies that receive federal awards need to complete the year-end SEFA disclosure forms and 
transmit them to SARS by the due date. This information is incorporated into the note disclosures 
that accompany the SEFA. See section H.3. for examples of disclosure forms. 
 
F.7. Definitions of Relevant Terms 
 

Amount Received: The amount of federal funds that one state agency received from another state 
agency as reported on the Transfers In report. This amount needs to agree with the amount the 
other agency reported on their Transfers Out report. 
 
Amount Sent: The amount of federal funds that one state agency sent to another state agency as 
reported on the Transfers Out report. This amount needs to agree with the amount the other agency 
reported on their Transfers In report. 
 
Award Contract Number: The contract number is provided by the awarding entity for a particular 
grant award. When no CFDA number exists for a federal program, the award contract number must 
be used as an identifying number for SEFA reporting.  
 
CFDA Number (Grant Category): Catalog of Federal Domestic Assistance identification number. 
This is a five-digit number with the first two digits identifying the federal agency and the last three 
identifying the specific agency program. (A complete list of CFDA numbers and information on each 
program can be found on the Internet at https://beta.sam.gov/help/assistance-listing). 
 
Contractor: An entity that receives a contract (or legal instrument) by which a non-federal entity 
purchases property or services needed to carry out the project or program under a federal award.. 
Although a non-federal entity may consider an agreement to be a contract, if the substance of the 
contract meets the definition of a federal award, the non-federal entity is not a contractor as defined 
here. 
 
Direct Awards: Awards of federal financial assistance received directly from a federal agency. 
 
Direct Expenditures: The amount of federal awards expended directly by the agency (e.g., paid to a 
contractor) in order to carry out a federal program. This amount does not include distributions to 
subrecipients. 
 
Expenditures Total: Total of direct expenditures made to contractors and distributions of funds 
passed-through to subrecipient organizations. 
 
Federal Award: Federal financial assistance and federal cost-reimbursement contracts that non-
federal entities receive directly from federal awarding agencies or indirectly from pass-through 
entities (further defined as “indirect award” below). It does not include procurement contracts (under 
grants or contracts) that the federal government uses to buy goods or services from a state agency 
in a contractor capacity. 
 
Indirect Awards: Awards of federal financial assistance that an agency received as a subrecipient of 
another organization, which could be another government or non-profit organization. A state agency 
may receive a portion of a federal grant from some other entity that has contracted with the agency 

https://beta.sam.gov/help/assistance-listing
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to provide services related to the grant. For example, Harvard University receives a federal grant to 
study sun exposure. Harvard University then passes through a portion of that federal grant to a state 
agency to conduct a study of sun exposure in the Northwest. In Uniform Guidance, indirect awards 
are identified as “subawards”. 
 
Non-federal Entity: A state, local government, or non-profit organization. 
 
Pass-through Entity: A non-federal entity that provides a federal award to a subrecipient to carry out 
a federal program. 
 
Pass-Through to Subrecipients: The amount that a state agency passed through to an organization 
that meets the definition of a subrecipient organization (not a contractor). 
 
Receiving Agency: The agency number of the state agency that received a transfer of federal funds 
from another state agency. 
 
Recipient: A non-federal entity that expends federal awards received directly from a federal 
awarding agency to carry out a federal program. 
 
Sending Agency: The agency number of the state agency that transferred federal funds to another 
state agency.  
 
State Agencies: See SEFA Contacts list at: 
http://www.oregon.gov/das/Financial/Acctng/Documents/SEFA_Contacts.pdf 
 
Subrecipient: A non-federal entity that receives an indirect award (as defined above) from a pass-
through entity to carry out part of a federal program; but does not include an individual that is a 
beneficiary of such program. A subrecipient may also be a recipient of other federal awards directly 
from a federal awarding agency. For purposes of reporting distributions of federal awards in the 
Oregon SEFA, a subrecipient is not a state agency. 
 
Subrecipient Tax ID Number: Tax identification number for the organization receiving the pass-
through assistance. This must be a valid Tax Identification Number. 
 
Total Amount Passed Through: The total amount passed through to a subrecipient organization. 
 
 

http://www.oregon.gov/das/Financial/Acctng/Documents/SEFA_Contacts.pdf
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